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iWeb Step-by-Step

iWeb makes it easy to create elegant web pages using your own photos, 
music, and videos created in iLife. And, if you have a .Mac membership, 
publishing sites is just a couple of clicks away. These custom sites can be 
used to share and present lessons. Your situation may be different, so these 
lessons assume that you’ll be giving your finished web pages to a website 
administrator to publish.

This step-by-step guide is designed to supplement the videos on the DVD. 
By using both, you can quickly create your own web pages, blogs, and photo 
galleries, and post them on your website. The tutorials here will lead you 
through creating specific parts of the ocean field trip project.



iWeb Step-by-Step

2	 For personal use only. Not for resale.Getting Started With A Welcome Page

Getting Started With A Welcome Page
Basic web pages have a few common elements—some text, some links, and a few graphics, 
artfully displayed. Creating a basic page is easy with iWeb, with its built-in page templates and 
graphics. Although we’ll get started by building a Welcome page, these techniques apply to 
any page you create using iWeb.

To create a welcome page in iWeb:

Open iWeb by clicking its icon in the Dock. If you’ve removed the iWeb icon from the 1	
Dock, double-click its icon in your Applications folder.

If this is the first time you’ve launched iWeb, it will display the built-in page templates.

   

iWeb has many built-in 
themes, each with several page 
templates. We’ve chosen the 
Goldenrod theme for our tide 
pool site.

If you’ve already launched iWeb, it will load the last site you worked on. To access the page 
templates, choose File -> New Site, or type Command-Shift-N.
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In the theme column on the left, choose a theme for your site. Next, select the Welcome 2	
template on the right, and click Choose. 

The Welcome page template loads in the main iWeb window.

   

We’ll use the Welcome page 
template for our first tide pool 
project page.

Click the headline text and type a new headline.3	

The text you type replaces the placeholder text.

   

Replacing the placeholder 
can have some unintended 
consequences, such as our 
two-line headline. We’ll fix  
that shortly.
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Select the headline and click Fonts in the lower-right corner of the window.4	

The Font panel appears.

   

The Font panel lets us control 
the font family, typeface, and 
size of text on the page— 
as well as its color and style.

Slide the slider on the right to adjust the size of the selected text. Alternatively, type a new 5	
font size in the panel’s Size field and press Return.

The headline font is adjusted to the size you set.

   

By reducing the headline’s 
font size, we can make it fit 
comfortably on one line.



iWeb Step-by-Step

For personal use only. Not for resale.	 5Getting Started With A Welcome Page

Click the Font panel’s close box, then with the headline text still selected, click the 6	
Inspector button in the lower-right corner of the window.

The Inspector panel appears.

   

The Inspector panel lets us 
control the behavior and style 
of iWeb page elements.

In the Inspector panel, click the Text Inspector button, and then click the Center Text 7	
button in the Color & Alignment section.

The headline is centered.

   

By clicking Center in the Text 
Inspector, we’ve centered the 
headline text on the page.
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Click the close button on the Inspector, and then select any graphics that need to be 8	
moved or resized, and do one or more of the following:

•	� Move graphics by dragging them to new locations—you may have to click carefully to 
select the graphic you want

•	Resize graphics by dragging the resize handles at the corners

To make the headline more legible—and more attractive—we’ve moved  
the leaves in the upper-right corner farther to the right, and we’ve moved  
the upper and lower lines to match the length of our new headline.

Click each text area on the page, and replace the placeholder text with your actual page 9	
text. You can do this by typing the text, or by pasting copied text. When pasting, choose 
Edit -> Paste and Match Style. Remove any unneeded text areas by selecting them and 
then pressing Delete.

The page text is customized.

   

We’ve customized all of the 
text on the page—next comes 
the graphics.
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In the lower-right part of the window, click the Media button, and then click Photos.10	

The Media browser appears, showing your iPhoto library and albums.

   

All of our tide pool images in 
iPhoto—including the iPhoto 
albums—are available through 
the Media browser.

Drag the images you want to use from the Media browser onto the placeholder images.11	

The images that you drop will replace the placeholder images on the page.

   

Simply drag tide pool pictures 
from the Media browser onto 
the placeholders to add them 
to our site.
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Close the media browser. Fine-tune your images by doing one or more of the following  12	
to them:

•  �Double-click an image to bring up the Edit Mask menu. Slide the slider to change the 
size of the image, and drag it to move the image inside the mask.

    
To move the image inside  
the mask, simply drag it.

•  �Select an image, and then click the Inspector button to bring up the Inspector window. 
Click the Metrics icon in the Inspector, and then drag the rotation control to rotate  
the image.

    

We’ve rotated this image clockwise 
by turning the Rotate control at the 
bottom of the window.
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•  �Select an image, and then click the Graphic button in the Inspector window. Adjust  
the image’s drop shadow settings. Close the Inspector window when you’re done.

    

To adjust a drop shadow, simply change 
the controls in the Shadow portion of the 
Inspector panel. Here, we’ve deepened 
the shadow by increasing its offset.

•  �Select an image, and then click the Adjust button in the bottom of the window.  
In the controls that pop up, adjust the image’s saturation, brightness, contrast, and  
other settings. Close the control panel when you’re finished.

    

By sliding the Saturation control 
to the right, we’ve saturated the 
starfish’s color a bit.

You’ve just created a welcome page, ready for publishing.
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Creating A Photo Page
iWeb lets you build photo pages from individual images, or even from iPhoto albums.

To create a photo page:

With your site open in iWeb, click the + button on the bottom-left part of the window.  1	
In the Templates pane that slides down, select a theme and then the Photos template,  
and then click Choose.

A photo page template loads.

   

The photo page template 
serves as a starting point for 
our tide pool pictures page, 
with some placeholder text 
and a few images.
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In the lower-right portion of the page, click the Media button, then click Photos in the 2	
resulting Media panel. 

The iPhoto image library loads in the Media browser.

   

The Media browser shows 
all of the tide pool photos in 
iPhoto’s library. We’ll use these 
to populate the template.

Drag your first photo from the Media browser to the placeholder on the photo page.3	

The image is loaded on the page, and the rest of the images disappear.

   

The first image dropped on the 
page loads in the upper-left 
corner of the page.
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Continue to drag photos onto the page—make sure you drop them in the blue 4	
rectangle—until you’ve added all of the photos you want.

   

When you drag a photo onto 
the page, the cursor takes on 
a green circle with a white 
“+”—indicating that the image 
will be added to the page 
where you drop it.

Close the media browser. Double-click the caption text below each photo, then type the 5	
caption you want. Do the same for the headline and text at the top of the page.

   

By double-clicking each 
headline, description, and 
caption, we can make the page 
more descriptive of our tide 
pool project.
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Click an image on the page to bring up the Photo Grid controls. In this panel, you can 6	
change settings for the entire page. Do the following:

•	� Select the border you’d like to use

•	� Set the number of columns

•	� Change the spacing between pictures

•	� Adjust the number of photos per page

•	� Increase or decrease the number of lines for each photo caption

   

The Photo Grid control panel lets 
you set how the photos appear on 
the page. Here, we’ve set it to three 
columns worth of photos with a white 
photo border, and two caption lines.

Rearrange pictures on the page by dragging them to new locations. As you do, the 7	
pictures on the page will move to make room for the picture you’re moving.

   

Drag images on the page to 
rearrange them—the other 
pictures on the page will move 
out of the way to make room.
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Creating A Photo Album Page
iWeb’s integration with iLife makes it easy to build a photo album page using an existing 
iPhoto album.

To create a photo album:

With your site open in iWeb, click the + button on the bottom-left part of the window. In 1	
the Templates pane that slides down, select a theme and then the Photos template, and 
then click Choose.

An album template page loads.

   

The Album template page 
is our starting point. Here, 
we’ll eventually include three 
separate albums.
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In the lower-right corner of the window, click the Media browser button, and then click 2	
Photos.

The Media browser loads the iPhoto library contents.

   

All of our tide pool images 
in iPhoto are available in the 
Media browser.

In the Media browser, scroll down to the albums section, and then drag an album from 3	
the Media browser onto the album placeholder.

   

Here, we’re dragging our 
Moss Beach Tide Pools album 
(created in iPhoto) onto our 
album page.
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iPhoto creates a new photo page and populates it with pictures from the album you  
just dropped.

   

When you drop an album 
onto the album page, iWeb 
automatically adds it to the 
album index, and then it 
creates a new photo page. 
Here, iWeb has created a photo 
page from our iPhoto album.

Close the Media browser, and then customize the headlines, captions, and photos you did 4	
in steps 5-7 of “Creating A Photo Page.”

   

We’ve edited the placeholder 
text to tell our visitors about 
the Moss Beach tide pools.
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In the left column, click My Albums.5	

The site’s main album page loads. The placeholder image has been replaced with the first 
image from the album you dropped.

   

iWeb has automatically 
created an album for us, using 
the iPhoto album title as a 
description underneath the 
image. The page title and links 
at the top of the page are up to 
us to customize.

In the left column, drag the photo page you created in “Creating A Photo Page” onto the 6	
My Albums item.

The photo page is added to the photo album index.

   

To add the Photos page we created earlier to 
our new album index, we simply drag it where 
we want it to appear—in this case, right below 
the Moss Beach album.
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Repeat Steps 2-5 to add any other iPhoto albums to your album index.7	

   

Using Steps 2-5, we’ve added 
a Point Lobos album to our 
albums index.

Double-click each text area and type new headlines and captions to replace the 8	
placeholders.

   

We’ve customized the 
placeholder headlines to 
describe our field trip.

Your photo album index and all of the photo albums are complete.
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Creating A Blog
iWeb lets you create and maintain a blog with ease—and that’s a great way to share up-to-
date information on a class project.

To create a blog:

With your site open in iWeb, click the + button on the bottom-left part of the window. 1	
In the Templates pane that slides down, select a theme and then the Blog template, and 
then click Choose.

A blog template page loads, and two additional pages are created: a blog index and a 
blog archive. The archive page is automatically updated; we’ll have to make some changes 
to the index page later.

   

Our tide pool blog starts with 
one template entry—we’ll 
customize it and add more 
entries later.
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Double-click each text area, and type new text to replace the placeholder text. This 2	
includes the page title, the caption, the blog entry headline, and the blog entry. 

The page is ready for pictures. Notice that the entry name at the top has changed to 
match the title you typed below.

   

The entry title at the top is the 
same as the headline below 
the image—change one, and 
the other changes.

Click the Media button to open the Media browser, and then click Photos. Drag a picture 3	
from the media browser onto the placeholder image.

The image you dragged replaces the placeholder.

   

We’ve replaced the placeholder 
image with a picture of a 
seagull—dragged directly from 
the Media browser.
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By default, the blog entry is set to the current day. If you need to change the date, click 4	
the entry date in the entry list. Otherwise, skip to Step 6.

A calendar appears.

   

The calendar pane lets us choose 
a date for our blog entry—if it’s 
different than the current date.

Choose a different date for your blog entry by double-clicking it on the calendar.5	

The calendar closes and the blog entry is updated with the new date.

   

Once you close the calendar, 
the blog entry date is changed 
as well.
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At the top of the window, click Add Entry.6	

A new entry is created in the entry list, and a new blog entry template is opened below.

   

By clicking Add Entry,  you 
create a new blog entry page. 
Repeat this each time you want 
to add a new entry to the blog.

Repeat Steps 2-5 for this blog entry.7	

Your second blog entry is complete.

   

We’ve replaced the text and 
images on the second page 
with some from our Moss 
Beach information.
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Add another blog entry by clicking Add Entry, and then repeating Steps 2-5. This time, 8	
delete the image by selecting it, and pressing Delete.

   

Our page template came 
complete with an image,  
which we’ve removed.

From the Web Widgets popup icon at the bottom of the page, choose Google Maps.9	

A default Google Map widget is added to the page.

   

The Google Maps Web Widget 
defaults to a Cupertino, California 
address. We’ll change that.
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Type the address for the map and click Apply.10	

The map widget updates with the new location.

   

By entering the address of our field 
trip, we’ve adjusted our Google 
Maps Web Widget to reflect our 
Point Lobos location.

Move and resize the widget, text areas, and any graphics to clean up the page.11	

   

We’ve cleaned up our third 
blog entry by moving text 
around and moving and 
resizing the Google Maps  
Web Widget.

The location blog entry is ready.
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In the left column, click the blog index.12	

The blog index loads. While the entries at the bottom have been updated, the image and 
text at the top need to be customized.

   

Our Blog index draws from the 
blog entries to populate the 
bottom of the page—but we 
still need to customize the top.

Double-click each text area, and type new text to replace the placeholder text. Next, open 13	
the Media browser and replace the placeholder picture with one of your own.

   

We’ve changed the placeholder 
image of the singers to a photo 
from our field trip.

Your blog is now ready.
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Creating A Podcast
Like blogs, creating a podcast is a great way to provide audio updates on a class project—and 
iWeb makes it easy to post a podcast that you created in GarageBand, or to display a video 
podcast from an iMovie project.

To create audio and video podcast pages:

With your site open in iWeb, click the + button on the bottom-left part of the window. In 1	
the Templates pane that slides down, select a theme and then the Podcast template, and 
then click Choose.

A new podcast index page loads.

   

A new podcast page looks— 
and works—very much like  
a blog page. It has an index,  
a page for each entry, and  
an archive.
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Open the Media browser, and then click Audio. 2	

The iTunes and GarageBand libraries load.

   

The Audio part of the Media 
inspector shows all the iTunes 
and GarageBand library 
contents.

In the Media browser, select GarageBand, and then drag a podcast episode onto the 3	
placeholder movie.

The podcast audio is placed on the page.

   

After we drop a podcast 
episode onto the template, 
the audio appears at the 
bottom—but we’ll need to add 
our own image.
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In the Media browser, click Photos, drag an image onto the podcast placeholder, and then 4	
close the Media browser.

   

We’ve used the school logo 
as the opening image for our 
podcast.

Edit the headline, caption, and description on the page by double-clicking each text area 5	
and typing new text.

   

We’ve customized the text  
on the page to describe our 
audio podcast.

The audio podcast page is finished.
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At the top of the screen, click Add Entry. 6	

A new podcast page is added to your site.

   

We’ve created a second 
podcast page to serve as  
home for our video podcast.

Open the Media browser, click Movies, and drag a movie from the browser onto the 7	
placeholder. Close the Media browser window.

The movie is added to the page.

   

After dragging a movie 
from the inspector to the 
placeholder, it appears on the 
page. Here, we’ve used a movie 
we created in iMovie.
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Command-click the border around the movie and the caption and then press Delete. 8	

Both elements are deleted from the page.

   

We’ve removed the caption 
and borders from the page  
to focus on the movie.

Move the movie just below the navigation elements, and then drag the lower-right corner 9	
to make the movie larger.

   

By moving the movie and 
resizing it, we’ve placed it  
front and center.
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Adjust the location of the other elements on the page, and then replace the placeholder 10	
headlines and text with your own.

   

We’ve replaced the headlines 
and the summary with our  
own text. Notice how the name 
of the top entry changed after 
we changed the headline 
below the movie.

Click the Podcast index in the left column. In the Podcast episode list that opens at the 11	
top of the page, replace the placeholder headlines and text with your own—the episode 
summaries at the bottom should already be updated.

   

Our index page is nearly 
complete—we’ve customized 
the text on the index page by 
replacing the placeholder text.
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Replace the placeholder picture with one of the images from the Media browser.12	

   

Finally, we’ve replaced the 
default image with one of our 
own from the tide pools field 
trip.

The podcast section of your site is complete.
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Managing Navigation And Links
iWeb makes it easy to manage your site’s navigation and to create links to other pages—or 
even other sites.

To manage your site’s navigation and links:

Open your site in iWeb. On the left, rearrange the elements by dragging them up or down.1	

The navigation elements at the top of each page change to reflect the new order.

   

Before

   

After

By dragging an element on 
the left to a new position, the 
navigation on the right changes. 

Select text that you’d like to make into a hyperlink, and click the Inspector button at the 2	
lower-right corner of the window.

The Inspector window opens.

   

The Inspector window is 
essential to creating links. 
Here, it’s opened to the Site 
Inspector by default—but we’ll 
change that.
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Click the Link icon in the Inspector window, and check the “Enable as a Hyperlink” 3	
checkbox. In the URL field, type the URL to which you’re linking.

   

We’ve turned the page 
headline into a link to 
Wikipedia by changing a 
couple of settings in the Link 
Inspector panel.

Now let’s create a link from an image. With the Link Inspector still open, select an image. 4	
Check the “Enable as a Hyperlink” checkbox. In the URL field, type the URL to which  
you’re linking.

   

We can do the same thing with 
an image—select it, and then 
use the Link Inspector panel to 
create a link to another page.
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Publishing Your Site
The final step in creating a website is publishing it. We’re assuming that you have web hosting 
arrangements with your school’s website administrator.

To publish a site:

With your site open in iWeb, choose File -> Publish to a Folder.1	

A pane slides down.

   

The site publishing pane lets  
us choose a folder to publish 
the site in. It also requires the 
URL for the site so RSS feeds 
work properly.

In the “Enter the URL for your site” field, type your website’s URL. Next, choose a location to 2	
save the site.

   

We’ve created a folder for our 
tide pool site, and entered the 
URL for our school’s web site.
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Click Choose.3	

The Content Rights dialog box appears, asking you to make sure you own copyrights or 
have permission for everything that you publish.

   

Before publishing, be sure you 
have rights to use all of the 
content in your site.

Click Continue.4	

iWeb prepares the site for publication, saving the files to the place you indicated earlier.

   

As you publish, a small 
progress bar appears 
at the top of the page.

Once finished, a pane slides down with additional .Mac publishing information. Click OK.5	

   

Once you’ve finished 
publishing your site, you’ll be 
notified that it’s complete.

Your site is now ready for publication. Follow the instructions given to you by your school’s 
website administrator to upload and publish your site.
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